
CALIBRATION PROCEDURE

Isolated M/S Series
This document contains instructions for calibrating National Instruments 
isolated M/S Series data acquisition (DAQ) devices, which include the 
NI 6154, NI 6230, NI 6232, NI 6233, NI 6236, NI 6238, and NI 6239.

This document does not discuss programming techniques or compiler 
configuration. The NI-DAQmx driver contains online help files that 
provide compiler-specific instructions and detailed function explanations. 
You can add these help files when you install NI-DAQmx on the calibration 
computer.
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Conventions
The following conventions appear in this manual:

<> Angle brackets that contain numbers separated by an ellipsis represent 
a range of values associated with a bit or signal name—for example, 
AO <3..0>.

» The » symbol leads you through nested menu items and dialog box options 
to a final action. The sequence File»Page Setup»Options directs you to 
pull down the File menu, select the Page Setup item, and select Options 
from the last dialog box.

This icon denotes a note, which alerts you to important information.

bold Bold text denotes items that you must select or click in the software, such 
as menu items and dialog box options. Bold text also denotes parameter 
names.

italic Italic text denotes variables, emphasis, a cross-reference, or an introduction 
to a key concept. Italic text also denotes text that is a placeholder for a word 
or value that you must supply.

monospace Text in this font denotes text or characters that you should enter from the 
keyboard, sections of code, programming examples, and syntax examples. 
This font is also used for the proper names of disk drives, paths, directories, 
programs, subprograms, subroutines, device names, functions, operations, 
variables, filenames, and extensions.

monospace italic Italic text in this font denotes text that is a placeholder for a word or value 
that you must supply.

Platform Text in this font denotes a specific platform and indicates that the text 
following it applies only to that platform.

Software
Calibration requires the latest NI-DAQmx driver. NI-DAQmx includes 
high-level function calls to simplify the task of writing software to calibrate 
devices. The driver supports many programming languages, including 
LabVIEW, LabWindows™/CVI™, C/C++, C#, and Visual Basic .NET.



© National Instruments Corporation 3 Isolated M/S Series Calibration Procedure

Documentation
The following documents are your primary references for writing your 
calibration utility with NI-DAQmx:

• The DAQ Getting Started Guide for NI-DAQ 8.3 or later provides 
instructions for installing and configuring NI-DAQ devices.

• The NI-DAQmx Help includes information about creating applications 
that use the NI-DAQmx driver.

• The NI-DAQmx C Reference Help includes information about the 
functions in the driver.

• The following DAQ documentation provides information about your 
DAQ device:

– The NI 6230 User Manual and NI 6230 Specifications for 
PCI/PXI-6230 devices

– The NI 6232/6233 User Manual and NI 6232/6233 Specifications 
for PCI/PXI-6232 and PCI/PXI-6233 devices

– The NI 6236 User Manual and NI 6236 Specifications for 
PCI/PXI-6236 devices

– The NI 6238/6239 User Manual and NI 6238/6239 Specifications 
for PCI/PXI-6238 and PCI/PXI-6239 devices

– The S Series User Manual and NI 6154 Specifications for 
PCI-6154 devices

Calibration Interval
Isolated M/S Series devices should be calibrated at regular intervals as 
defined by the measurement accuracy requirements of your application. 
National Instruments recommends that you routinely perform a complete 
calibration at least once every year. You can shorten this interval based 
on the accuracy demands of your application or requirements of your 
processes.

Password
The default password for password-protected operations is NI.

Test Equipment
National Instruments recommends that you use the instruments in Table 1 
for calibrating an isolated M/S Series device.
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Table 1.  Recommended Calibration Equipment

 Equipment Recommended Model Comments

Calibrator Fluke 5700A If this instrument is unavailable, use a voltage source 
that is at least 10 ppm accurate for 16-bit voltage input 
devices, or use a current source that is at least 100 ppm 
accurate for 16-bit current input devices.

DMM NI 4070 If this instrument is unavailable, use a multiranging 
6½-digit DMM with an accuracy of 40 ppm or better.

Counter Agilent 53131A If this instrument is unavailable, use a counter accurate 
to 0.01%.

PXI chassis NI PXI-1042, 
NI PXI-1042Q

Use with PXI modules.

Power supply NI 4110 (NI 6238/6239 Devices) For analog output verification, 
use any 10–30 VDC, 100 mA power supply.

(NI 6232/6233/6238/6239 Devices) For counter 
verification, use any 5 VDC, 200 mA power supply.

Resistor — (NI 6238/6239 Devices) For analog output verification, 
use any 100 Ω resistor.

(NI 6232/6233/6238/6239 Devices) For counter 
verification, use any 1 kΩ resistor.

Low thermal 
copper EMF 
plug-in cable

Fluke 5440A-7002 Do not use standard banana cables.

Shielded DAQ 
cable

NI DB37M-DB37F-EP Use with NI 6154/6230/6236 devices.*

NI SH37F-37M-1 Use with NI 6232/6233/6238/6239 devices.

DAQ 
accessory

NI CB-37F-LP Low profile terminal block with 37 screw terminals.

NI CB-37FH Horizontal DIN-mountable terminal block with 
37 screw terminals.

NI CB-37FV Vertical DIN-mountable terminal block with 37 screw 
terminals.

NI CB-37F-HVD 37-pin DIN rail screw terminal block, UL Recognized 
derated to 30 Vrms, 42.4 Vpk, or 60 VDC.

* You can also use the NI SH37F-37M-1 cable with NI 6230/6236 devices.
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Test Conditions
Follow these guidelines to optimize the connections and the environment 
during calibration:

• Keep connections to the device as short as possible. Long cables and 
wires can act as antennae, which could pick up extra noise that might 
affect measurements.

• Use shielded copper wire for all cable connections to the device. 
Use twisted-pair wire to eliminate noise and thermal offsets.

• Maintain the ambient temperature between 18–28 °C. The device 
temperature will be greater than the ambient temperature.

• Keep relative humidity below 80%.

• Allow a warm-up time of at least 15 minutes to ensure that the 
measurement circuitry is at a stable operating temperature.

• (PXI Devices) Ensure that the PXI chassis fan speed is set to HIGH, the 
fan filters are clean, and the empty PXI slots contain filler panels.

Calibration Procedure
The calibration process has six steps.

1. Initial Setup—Configure your device in NI-DAQmx.

2. Self-Calibration—Adjust the device to account for short-term 
environmental changes. No external signal is required.

3. Checking Device Temperature Changes—Verify that the current 
device temperature will not cause you to incorrectly calibrate your 
device.

4. Verification Procedure—Verify the existing operation of the device. 
This step allows you to confirm that the device was operating within 
its specified range prior to calibration.

5. Adjustment Procedure—Perform an external calibration that adjusts 
the device calibration constants with respect to a known voltage 
source.

6. Reverification—Perform another verification to ensure that the device 
is operating within its specifications after adjustment.

These steps are described in detail in the following sections. Although NI 
recommends that you verify all ranges, you can save time by checking only 
the ranges used in your application.
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Initial Setup
Configure your isolated M/S Series device in Measurement & Automation 
Explorer (MAX) to communicate with NI-DAQmx.

The following procedure describes how to configure a device in MAX.

1. Install the NI-DAQmx driver software.

2. Power off the computer/chassis that will hold the device and install the 
device in an available slot.

3. Power on the computer and launch MAX.

4. Configure the device identifier and select Self-Test to ensure that the 
device is working properly.

Note When a device is configured with MAX, it is assigned a device identifier. Each 
function call uses this identifier to determine which DAQ device to calibrate.

Self-Calibration
Self-calibration should be performed after the device has warmed up for the 
recommended time period of 15 minutes. Call self-calibration before doing 
the first verification. This function measures the onboard reference voltage 
of the device and adjusts the self-calibration constants to account for any 
errors caused by short-term fluctuations in the environment. Disconnect all 
external signals when you self-calibrate a device.

You also can initiate self-calibration using MAX, by completing the 
following steps.

1. Launch MAX.

2. Select My System»Devices and Interfaces»NI-DAQmx 
Devices»your device.

3. Initiate self-calibration using one of the following methods:

• Click Self-Calibrate in the upper right corner of MAX.

• Right-click the name of the device in the MAX configuration tree 
and select Self-Calibrate from the drop-down menu.

LabVIEW Block Diagram NI-DAQmx Function Call

Call DAQmxSelfCal with the following 
parameters:

Device_Name[]: dev1
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Checking Device Temperature Changes
Device temperature changes (greater than ±10 °C since the previous 
external calibration or greater than ±1 °C since the previous 
self-calibration) can cause you to incorrectly calibrate your device. After 
self-calibrating your device (as described in the Self-Calibration section), 
complete the following steps to compare the current device temperature to 
the temperatures measured during the last self-calibration and external 
calibration.

1. Read the current temperature measured by the device by using the 
DevTemp property node.

2. Get the temperature of the device recorded during the last 
self-calibration by using the SelfCal.LastTemp property node.

If the difference between the current temperature and the temperature 
from the last self-calibration is greater than 1 °C, the limits in the 
calibration tables are not valid. 

3. Get the temperature of the device recorded during the last external 
calibration by using the ExtCal.LastTemp property node.

If the difference between the current temperature and the temperature 
from the last external calibration is greater than 10 °C, the limits in the 
calibration tables are not valid. 

LabVIEW Block Diagram NI-DAQmx Function Call

Call DAQmxGetCalDevTemp with the 
following parameter:

deviceName: dev1

LabVIEW Block Diagram NI-DAQmx Function Call

Call DAQmxGetSelfCalLastTemp with 
the following parameter:

deviceName: dev1

LabVIEW Block Diagram NI-DAQmx Function Call

Call DAQmxGetExtCalLastTemp with 
the following parameter:

deviceName: dev1
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Note ±10 °C is the maximum temperature change for most DAQ devices. To find the valid 
temperature drifts for your isolated M/S device, refer to the Absolute Accuracy table(s) in 
your DAQ device specifications document.

Note You also can read the current device temperature, the temperature during the 
last self-calibration, and the temperature during the last external calibration in MAX. 
Launch MAX, select Select My System»Devices and Interfaces»NI-DAQmx Devices»
your device, then click the Calibration tab.

If the device temperature is outside the maximum range, you should choose 
one of the following options:

• Change the test limits to include the additional error due to temperature 
drift. Refer to your DAQ device specifications document for more 
information.

• Change the system so that the temperature will be closer to the 
temperature recorded during the last external calibration.

Verification Procedure
Verification determines how well the DAQ device is meeting its 
specifications. By performing this procedure, you can see how your device 
has operated over time. You can use this information to help determine the 
appropriate calibration interval for your application.

The verification procedure is divided into the major functions of the device. 
Throughout the verification process, use the appropriate table in the Test 
Limits section to determine if your device needs to be adjusted.

Analog Input Verification
Since isolated M/S Series devices have many different ranges, you must 
verify measurements for each available range. Isolated M/S Series devices 
have two analog input types—voltage and current. Table 2 lists the isolated 
M/S Series device analog input types.

(NI 6154 Devices Only) NI 6154 devices have one analog-to-digital converter 
(ADC) per analog input channel, so you must perform verification on each 
channel.

Table 2.  Isolated M/S Series Device Analog Input Types

Device Analog Input Type

NI 6154, NI 6230, NI 6232, NI 6233 Voltage Input

NI 6236, NI 6238, NI 6239 Current Input
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(NI 6230/6232/6233 Devices Only) NI 6230/6232/6233 devices have one 
ADC, so you only need to perform verification on one analog input 
channel.

(NI 6236/6238/6239 Devices Only) You must perform verification on all analog 
input channels of the current input devices because each analog input 
channel has its own sense resistor.

Complete the following steps to verify analog input performance.

1. Refer to Table 3 to determine connections between the device and the 
calibrator. 

Note (NI 6154 Devices Only) If your calibrator has a guard connection, leave it unconnected.

Note (NI 623x Devices Only) If your calibrator has a guard connection, connect that terminal 
to AI GND. If your calibrator does not have a guard connection, connect the negative 
output to AI GND. For more information, refer to your DAQ device user manual.

Table 3.  Analog Input Connections

Device Analog Input

Calibrator

Positive Output Negative Output Guard Connection

NI 6154* AI 0 Pin 20 Pin 1 —

AI 1 Pin 3 Pin 21

AI 2 Pin 23 Pin 4

AI 3 Pin 6 Pin 24

NI 6230* AI 0 Pin 20 Pin 1 AI GND (pin 2)

NI 6232*, 
NI 6233*

AI 0 Pin 1 Pin 20 AI GND (pin 3)

NI 6236† AI 0+, AI 0– Pin 20 Pin 1 AI GND (pin 2)

AI 1+, AI 1– Pin 3 Pin 21

AI 2+, AI 2– Pin 23 Pin 4

AI 3+, AI 3– Pin 6 Pin 24
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2. Choose the table from the Test Limits section that corresponds to the 
device you are verifying. This table shows all acceptable settings for 
the device type. NI recommends that you verify all ranges, although 
you may want to save time by checking only the ranges used in your 
application.

3. Create a task using DAQmxCreateTask.

4. (NI 6154/6230/6232/6233 Devices Only) Add a voltage channel to the task 
using the DAQmx Create Virtual Channel VI and configure the 
channel. Use the appropriate analog input table in the Test Limits 
section to determine the minimum and maximum values for the input 
range being verified on your device.

Note Throughout the procedure, refer to the NI-DAQmx function call parameters for the 
LabVIEW input values.

NI 6238†, 
NI 6239†

AI 0+, AI 0– Pin 1 Pin 20 AI GND (pin 3)

AI 1+, AI 1– Pin 21 Pin 2

AI 2+, AI 2– Pin 22 Pin 4

AI 3+, AI 3– Pin 5 Pin 23

AI 4+, AI 4– Pin 6 Pin 25

AI 5+, AI 5– Pin 26 Pin 7

AI 6+, AI 6– Pin 27 Pin 9

AI 7+, AI 7– Pin 28 Pin 10

* NI 6154/6230/6232/6233 devices connect to calibrator positive and negative voltage outputs.
† NI 6236/6238/6239 devices connect to calibrator positive and negative current outputs.

LabVIEW Block Diagram NI-DAQmx Function Call

LabVIEW does not require this step.

Call DAQmxCreateTask with the following 
parameters:

taskName: AIVerificationTask
taskHandle: &taskHandle

Table 3.  Analog Input Connections (Continued)

Device Analog Input

Calibrator

Positive Output Negative Output Guard Connection
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5. (NI 6236/6238/6239 Devices Only) Add a current channel to the task using 
the DAQmx Create Virtual Channel VI and configure the channel. 
Use the appropriate analog input table in the Test Limits section to 
determine the minimum and maximum values for your device.

LabVIEW Block Diagram NI-DAQmx Function Call

Call DAQmxCreateAIVoltageChan with the 
following parameters:

taskHandle: taskHandle
physicalChannel: dev1/ai0
nameToAssignToChannel: 
myVoltageChannel
terminalConfig: 
DAQmx_Val_InputTermCfg_Diff

minVal: –10.0
maxVal: 10.0
units: DAQmx_Val_Volts
customScaleName: NULL

LabVIEW Block Diagram NI-DAQmx Function Call

Call DAQmxCreateAICurrentChan with the 
following parameters:

taskHandle: taskHandle
physicalChannel: dev1/ai0
nameToAssignToChannel: 
myCurrentChannel
terminalConfig: 
DAQmx_Val_InputTermCfg_Diff

minVal: –.02
maxVal: .02
units: DAQmx_Val_Amps
customScaleName: NULL
ShuntResistorLocation: Internal
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6. Configure timing for the acquisition using the DAQmx Timing VI.

7. Set the calibrator voltage or current to the test value indicated in the 
device table from the Test Limits section. 

8. Ensure that the calibrator output is enabled.

9. Start the acquisition using the DAQmx Start Task VI.

10. Acquire 10,000 points of voltage or current data, depending on which 
device you are verifying, using the DAQmx Read VI.

LabVIEW Block Diagram NI-DAQmx Function Call

Call DAQmxCfgSampClkTiming with the 
following parameters:

taskHandle: taskHandle
source: NULL
rate: 100000.0
activeEdge: DAQmx_Val_Rising
sampleMode: DAQmx_Val_FiniteSamps
sampsPerChan: 10000

LabVIEW Block Diagram NI-DAQmx Function Call

Call DAQmxStartTask with the following 
parameter:

taskHandle: taskHandle

LabVIEW Block Diagram NI-DAQmx Function Call

Call DAQmxReadAnalogF64 with the following 
parameters:

taskHandle: taskHandle
numSampsPerChan: –1
timeout: 10.0
fillMode: DAQmx_Val_GroupByChannel
readArray: data
arraySizeInSamples: 10000
sampsPerChanRead: &read
reserved: NULL
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11. Average the acquired values. Compare the resulting average to the 
upper and lower limits listed in the table. If the result is between these 
values, the device passes the test.

12. Clear the acquisition using the DAQmx Clear Task VI.

13. Repeat steps 3 through 12 until all values listed in the table have been 
verified.

14. (NI 6154/6236/6238/6239 Devices Only) Disconnect the calibrator from 
AI 0 and reconnect it to AI 1, making the connections in Table 3.

Repeat steps 3 through 13 for all AI channels on the device.

15. Disconnect the calibrator from the device.

You have finished verifying the analog input levels on your device.

Analog Output Verification
This procedure verifies the performance of all analog output channels. 
Isolated M/S Series devices have two analog output types—voltage and 
current. Table 4 lists the isolated M/S Series device analog output type and 
channel number.

Complete the following steps to verify analog output measurements.

1. Connect the power supply (if needed) and resistor (if needed), and 
connect the DMM to AO 0, as shown in Table 5. Make sure that the 
connection matches the type of output of your device.

LabVIEW Block Diagram NI-DAQmx Function Call

Call DAQmxClearTask with the following 
parameter:

taskHandle: taskHandle

Table 4.  Isolated M/S Series Device Analog Output Type and Channel Number

Device Analog Output Type Analog Output Channels

NI 6154, NI 6230, NI 6236 Voltage Output Four, AO <0..3>

NI 6232, NI 6233 Voltage Output Two, AO <0..1>

NI 6238, NI 6239 Current Output Two, AO <0..1>
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Figure 1.  NI 6238/6239 Resistor Location

Table 5.   Analog Output Connections

Device
Analog 
Output

DMM

100 Ω 
Resistor

Power Supply

Positive 
Input

Negative 
Input

Positive 
Input

Negative 
Input

NI 6154* AO 0 Pin 26 Pin 7 N/A N/A N/A

AO 1 Pin 9 Pin 27

AO 2 Pin 29 Pin 10

AO 3 Pin 12 Pin 30

NI 6230*, 
NI 6236*

AO 0 Pin 26 Pin 27 N/A N/A N/A

AO 1 Pin 9 Pin 27

AO 2 Pin 29 Pin 27

AO 3 Pin 12 Pin 27

NI 6232*, 
NI 6233*

AO 0 Pin 30 Pin 31 N/A N/A N/A

AO 1 Pin 12 Pin 31

NI 6238†, 
NI 6239†

AO 0 Pin 30 Pin 31 Between 
pin 30 and 

DMM+

AO Power 
Supply (pin 29)

AO GND 
(pin 31)

AO 1 Pin 12 Pin 31 Between 
pin 12 and 

DMM+

* NI 6154/6230/6232/6233/6236 devices connect to DMM positive and negative voltage inputs.
† NI 6238/6239 devices connect to DMM positive and negative current inputs. Refer to Figure 1 for resistor location.

AO 1
or AO 0

AO Power Supply

DMM

Power
Supply

+

+

100 Ω

(10–30 V)

12
or 30

29

31
AO GND

NI 6238/6239

–
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2. Choose the table from the Test Limits section that corresponds to the 
device you are verifying. This table shows all acceptable settings for 
the device. NI recommends that you verify all ranges, although you 
may want to save time by verifying only the ranges used in your 
application.

3. Create a task using DAQmxCreateTask.

4. (NI 6154/6230/6232/6233/6236 Devices Only) Add an AO voltage task 
using the DAQmx Create Virtual Channel VI and configure AO 0. 
Use the appropriate analog output table in the Test Limits section to 
determine the minimum and maximum values for your device.

Note Throughout the procedure, refer to the NI-DAQmx function call parameters for the 
LabVIEW input values.

5. (NI 6238/6239 Devices Only) Add an AO current task using the DAQmx 
Create Virtual Channel VI and configure AO 0. Use the appropriate 
analog output table in the Test Limits section to determine the 
minimum and maximum values for your device.

LabVIEW Block Diagram NI-DAQmx Function Call

LabVIEW does not require this step.

Call DAQmxCreateTask with the following 
parameters:

taskName: MyAOTask
taskHandle: &taskHandle

LabVIEW Block Diagram NI-DAQmx Function Call

Call DAQmxCreateAOVoltageChan with the 
following parameters:

taskHandle: taskHandle
physicalChannel: dev1/ao0
nameToAssignToChannel: 
AOVoltageChannel

minVal: –10.0
maxVal: 10.0
units: DAQmx_Val_Volts
customScaleName: NULL
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6. Start the generation using the DAQmx Start Task VI.

7. Write a voltage or current test point value from the table in the Test 
Limits section to the AO channel using the DAQmx Write VI.

8. Compare the resulting value shown by the DMM to the upper and 
lower limits in the table in the Test Limits section. If the value is 
between these limits, the device passes the test.

LabVIEW Block Diagram NI-DAQmx Function Call

Call DAQmxCreateAOCurrentChan with the 
following parameters:

taskHandle: taskHandle
physicalChannel: dev1/ao0
nameToAssignToChannel: 
AOVoltageChannel

minVal: 0
maxVal: .02
units: DAQmx_Val_Amps
customScaleName: NULL

LabVIEW Block Diagram NI-DAQmx Function Call

Call DAQmxStartTask with the following 
parameters:

taskHandle: taskHandle

LabVIEW Block Diagram NI-DAQmx Function Call

Call DAQmxWriteAnalogF64 with the 
following parameters:

taskHandle: taskHandle
numSampsPerChan: 1
autoStart: 1
timeout: 10.0
dataLayout: DAQmx_Val_GroupByChannel
writeArray: &data
sampsPerChanWritten: &samplesWritten
reserved: NULL
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9. Clear the acquisition using the DAQmx Clear Task VI.

10. Repeat steps 3 through 9 until all values have been tested.

11. Disconnect the DMM from AO 0, and reconnect it to AO 1, making the 
connections shown in Table 5.

12. Repeat steps 3 through 11 for AO 1.

(NI 6154/6230/6236 Devices Only) Repeat steps 3 through 11 for both 
AO 2 and AO 3.

13. Disconnect your DMM from the device.

You have finished verifying the analog output levels on your device.

Counter Verification
This procedure verifies the performance of the counter. Isolated M/S Series 
devices have only one timebase to verify, so only Counter 0 needs to be 
verified. It is not possible to adjust this timebase, so only verification can 
be performed. Complete the following steps to verify the counter.

1. Connect the counter, power supply (if needed), and resistor (if needed) 
to your DAQ device as shown in Table 6. 

LabVIEW Block Diagram NI-DAQmx Function Call

Call DAQmxClearTask with the following 
parameter:

taskHandle: taskHandle

Table 6.  Counter Connections

Device

Counter Power Supply

1 kΩ Resistor
Positive 
Output

Negative 
Output

Positive 
Source

Negative 
Source

NI 6154, 
NI 6230, 
NI 6236

CTR 0 OUT 
(pin 17)

D GND 
(pin 18)

N/A N/A N/A

NI 6232, 
NI 6238

CTR 0 OUT 
(pin 17)

P1.GND 
(pin 19)

P1.VCC 
(pin 35)

P1.GND 
(pin 19)

Between pin 17 and 
pin 19. 
Refer to Figure 2.

NI 6233, 
NI 6239

CTR 0 OUT 
(pin 17)

P1.GND 
(pin 35)

P1.VCC 
(pin 19)

P1.GND 
(pin 35)

Between pin 17 and 
pin 19. 
Refer to Figure 3.
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Figure 2.  NI 6232/6238 Resistor Location

Figure 3.  NI 6233/6239 Resistor Location

2. Create a task using DAQmxCreateTask.

3. Add a counter output channel to the task using the DAQmx Create 
Virtual Channel VI and configure the channel.

(NI 6154/6230/6236 Devices Only) Use a frequency of 5 MHz.

(NI 6232/6233/6238/6239 Devices Only) Use a frequency of 10 kHz.

Note Throughout the procedure, refer to the NI-DAQmx function call parameters for the 
LabVIEW input values.

LabVIEW Block Diagram NI-DAQmx Function Call

LabVIEW does not require this step.

Call DAQmxCreateTask with the following 
parameters:

taskName: MyCounterOutputTask
taskHandle: &taskHandle

P1.0 (CTR 0 OUT)

P1.VCC

Counter

Power
Supply

+

+

1 kΩ

(5 V)

17

35

19
P1.GND

NI 6232/6238

P1.0 (CTR 0 OUT)

P1.VCC

Counter

Power
Supply

+

+

1 kΩ

(5 V)

17

19

35
P1.GND

NI 6233/6239
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4. Configure the counter for continuous square wave generation using the 
DAQmx Timing VI.

5. Start the generation of a square wave using the DAQmx Start Task VI.

6. Configure the counter to measure frequency and use a 1 MΩ 
impedance.

7. Take the measurement of the square wave.

8. Compare the value read by your counter to the test limits shown on the 
table in the Test Limits section. If the value falls between these limits, 
the device passes the test.

LabVIEW Block Diagram NI-DAQmx Function Call

Call DAQmxCreateCOPulseChanFreq with 
the following parameters:

taskHandle: taskHandle
counter: dev1/ctr0
nameToAssignToChannel: 
CounterOutputChannel

units: DAQmx_Val_Hz
idleState: DAQmx_Val_Low
initialDelay: 0.0
freq: 5000000.0 or 10000.0
dutyCycle: .5

LabVIEW Block Diagram NI-DAQmx Function Call

Call DAQmxCfgImplicitTiming with the 
following parameters:

taskHandle: taskHandle
sampleMode: DAQmx_Val_ContSamps
sampsPerChan: 10000

LabVIEW Block Diagram NI-DAQmx Function Call

Call DAQmxStartTask with the following 
parameter:

taskHandle: taskHandle
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9. Stop the generation using the DAQmx Stop Task VI.

10. Clear the generation using the DAQmx Clear Task VI.

11. Disconnect the counter from your device.

12. (NI 6232/6233/6238/6239 Devices Only) Disconnect the power supply.

You have verified the counter on your device.

Adjustment Procedure
Use the isolated M/S Series adjustment procedure to adjust the analog input 
and output calibration constants. At the end of each calibration procedure, 
these new constants are stored in the external calibration area of the 
EEPROM. These values are password-protected, which prevents the 
accidental access or modification of any calibration constants adjusted by 
the metrology laboratory. The default password is NI.

Complete the following steps to perform device adjustment with a 
calibrator.

1. Connect the calibrator to the device using the connections listed in 
Table 7.

Note (NI 6154 Devices Only) If your calibrator has a guard connection, leave it unconnected.

Note (NI 623x Devices Only) If your calibrator has a guard connection, connect AI GND to 
the guard instead of the negative output. For more information, refer to your DAQ device 
user manual.

LabVIEW Block Diagram NI-DAQmx Function Call

Call DAQmxStopTask with the following 
parameter:

taskHandle: taskHandle

LabVIEW Block Diagram NI-DAQmx Function Call

Call DAQmxClearTask with the following 
parameter:

taskHandle: taskHandle
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2. Set your calibrator to output 7.50 V. 

Note (NI 6238/6239 Devices Only) Current input/output devices use a voltage for adjustment.

3. Open a calibration session on your device using the DAQmx Initialize 
External Calibration VI. The default password is NI.

Note Throughout the procedure, refer to the NI-DAQmx function call parameters for the 
LabVIEW input values.

Table 7.  Calibrator Connections

Device

Calibrator

Positive Output Negative Output Guard Connection

NI 6154* Pin 20, pin 3, 
pin 23, and pin 6

Pin 1, pin 21, 
pin 4, and pin 24

—

NI 6230* Pin 20 Pin 1 AI GND (pin 2)

NI 6232*,
NI 6233*

Pin 1 Pin 20 AI GND (pin 3)

NI 6236† Pin 20 Pin 8 AI GND (pin 2)

NI 6238†,
NI 6239†

Pin 1 Pin 8 AI GND (pin 3)

* NI 6154/6230/6232/6233 devices connect to calibrator positive and negative voltage outputs.
† NI 6236/6238/6239 devices connect to calibrator positive and negative current outputs.

LabVIEW Block Diagram NI-DAQmx Function Call

Call DAQmxInitExtCal with the following 
parameters:

deviceName: dev1
password: NI
calHandle: &calHandle
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4. Perform an external calibration adjustment.

(NI 6154 Devices Only) Use the DAQmx Adjust S-Series Calibration VI.

(NI 623x Devices Only) Use the DAQmx Adjust M-Series Calibration VI.

5. Save the adjustment to the EEPROM using the DAQmx Close External 
Calibration VI. This VI also saves the date, time, and temperature of 
the adjustment to the onboard memory.

Note If an error occurs during the adjustment procedure, no constants are written to the 
EEPROM.

6. Disconnect the calibrator from the device.

The device is now calibrated with respect to your external source.

After calibrating the device, you may want to verify the analog input and 
output operation. To do this, repeat the Verification Procedure section.

LabVIEW Block Diagram NI-DAQmx Function Call

Call DAQmxMSeriesCalAdjust or 
DAQmxSSeriesCalAdjust with the following 
parameters:

calHandle: calHandle
referenceVoltage: 7.5

LabVIEW Block Diagram NI-DAQmx Function Call

Call DAQmxCloseExtCal with the following 
parameters:

calHandle: calHandle
action: DAQmx_Val_Action_Commit
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Test Limits
The tables in this section list the specifications for isolated M/S Series 
devices. The specifications are divided into analog input, analog output, 
and counter/timer tables of values.

The following definitions describe how to use the information from the 
tables in this section:

• Range—Refers to the maximum allowable voltage range of an input 
or output signal.

• Test Point—The voltage value that is input or output for verification 
purposes. This value is broken down into two columns—Location and 
Value. Location refers to where the test value fits within the test range. 
Value refers to the voltage value to be verified and is in volts. Pos FS 
stands for positive full-scale and Neg FS stands for negative full-scale.

• 24-Hour Limits—The values shown in the 24-hour tables are the valid 
specifications when a device has been calibrated with an external 
source. The 24-Hour Limits column contains the Upper Limits and 
Lower Limits for the test point value. That is, when the device is within 
its 24-hour calibration interval, the test point value should fall between 
the upper and lower limit values. Upper and lower limits are expressed 
in volts or amps, depending on the device.

Note (NI 6154 Devices Only) NI 6154 devices only have 1-year limits specifications.

• 1-Year Limits—The specifications that the devices should meet if it 
has been one year between calibrations. The 1-Year Limits column 
contains the Upper Limits and Lower Limits for the test point value. 
That is, when the device is within its one year calibration interval, the 
test point value should fall between the upper and lower limit values. 
Upper and lower limits are expressed in volts or amps, depending on 
the device.

(NI 623x Devices Only) For M Series devices, calibration limits are valid 
only if the temperature of the device (as measured by the onboard 
temperature sensor) is within 10 °C of the last external calibration. 
You can find the data from the last external calibration in MAX.

• Counters—It is not possible to adjust the resolution of the 
counter/timers. Therefore, these values do not have a 1-year or 24-hour 
calibration period. However, the test point and upper and lower limits 
are provided for verification purposes.



Isolated M/S Series Calibration Procedure 24 ni.com

Is
ol

at
ed

 M
 S

er
ie

s 
Te

st
 L

im
its

NI
 6

23
0 

Te
st

 L
im

its
T

ab
le

s
8 

th
ro

ug
h

10
 in

cl
ud

e 
va

lu
es

 f
or

 th
e 

PC
I-

62
30

 a
nd

 P
X

I-
62

30
.

Ta
bl

e 
8.

  N
I6

23
0 

An
al

og
 In

pu
t V

al
ue

s

R
an

ge
 (

V
)

T
es

t 
P

oi
nt

24
-H

ou
r 

L
im

it
s

1-
Y

ea
r 

L
im

it
s

M
in

im
um

M
ax

im
um

L
oc

at
io

n
V

al
ue

 (
V

)
L

ow
er

 L
im

it
 (

V
)

U
pp

er
 L

im
it

 (
V

)
L

ow
er

 L
im

it
 (

V
)

U
pp

er
 L

im
it

 (
V

)

–1
0

10
P

os
 F

S
9.

98
9.

97
77

98
9.

98
22

02
9.

97
69

00
9.

98
31

00

–1
0

10
0

0
–0

.0
01

60
3

0.
00

16
03

–0
.0

01
60

3
0.

00
16

03

–1
0

10
N

eg
 F

S
–9

.9
8

–9
.9

82
20

2
–9

.9
77

79
8

–9
.9

83
10

0
–9

.9
76

90
0

–5
5

P
os

 F
S

4.
99

4.
98

88
34

4.
99

11
66

4.
98

83
85

4.
99

16
15

–5
5

0
0

–0
.0

00
81

7
0.

00
08

17
–0

.0
00

81
7

0.
00

08
17

–5
5

N
eg

 F
S

–4
.9

9
–4

.9
91

16
6

–4
.9

88
83

4
–4

.9
91

61
5

–4
.9

88
38

5

–1
1

P
os

 F
S

0.
99

8
0.

99
77

31
0.

99
82

69
0.

99
76

41
0.

99
83

59

–1
1

0
0

–0
.0

00
18

9
0.

00
01

89
–0

.0
00

18
9

0.
00

01
89

–1
1

N
eg

 F
S

–0
.9

98
–0

.9
98

26
9

–0
.9

97
73

1
–0

.9
98

35
9

–0
.9

97
64

1

–0
.2

00
0.

20
0

P
os

 F
S

0.
19

96
0.

19
95

06
0.

19
96

94
0.

19
94

88
0.

19
97

12

–0
.2

00
0.

20
0

0
0

–0
.0

00
07

0
0.

00
00

70
–0

.0
00

07
0

0.
00

00
70

–0
.2

00
0.

20
0

N
eg

 F
S

–0
.1

99
6

–0
.1

99
69

4
–0

.1
99

50
6

–0
.1

99
71

2
–0

.1
99

48
8



© National Instruments Corporation 25 Isolated M/S Series Calibration Procedure

Ta
bl

e 
9.

  N
I6

23
0 

An
al

og
 O

ut
pu

t V
al

ue
s

R
an

ge
 (

V
)

T
es

t 
P

oi
nt

24
-H

ou
r 

L
im

it
s

1-
Y

ea
r 

L
im

it
s

M
in

im
um

M
ax

im
um

L
oc

at
io

n
V

al
ue

 (
V

)
L

ow
er

 L
im

it
 (

V
)

U
pp

er
 L

im
it

 (
V

)
L

ow
er

 L
im

it
 (

V
)

U
pp

er
 L

im
it

 (
V

)

–1
0

10
P

os
 F

S
9.

98
9.

97
76

71
9.

98
23

29
9.

97
67

73
9.

98
32

27

–1
0

10
0

0
–0

.0
01

73
0

0.
00

17
30

–0
.0

01
73

0
0.

00
17

30

–1
0

10
N

eg
 F

S
–9

.9
8

–9
.9

82
32

9
–9

.9
77

67
1

–9
.9

83
22

7
–9

.9
76

77
3

Ta
bl

e 
10

.  
NI

62
30

 C
ou

nt
er

 V
al

ue
s

Se
t 

P
oi

nt
 (

M
H

z)
L

ow
er

 L
im

it
 (

M
H

z)
U

pp
er

 L
im

it
 (

M
H

z)

5
4.

99
97

5
5.

00
02

5



Isolated M/S Series Calibration Procedure 26 ni.com

NI
 6

23
2/

62
33

 T
es

t L
im

its
T

ab
le

s
11

 th
ro

ug
h

13
 in

cl
ud

e 
va

lu
es

 f
or

 th
e 

PC
I-

62
32

, P
X

I-
62

32
, P

C
I-

62
33

, a
nd

 P
X

I-
62

33
.

Ta
bl

e 
11

.  
NI

62
32

/6
23

3 
An

al
og

 In
pu

t V
al

ue
s

R
an

ge
 (

V
)

T
es

t 
P

oi
nt

24
-H

ou
r 

L
im

it
s

1-
Y

ea
r 

L
im

it
s

M
in

im
um

M
ax

im
um

L
oc

at
io

n
V

al
ue

 (
V

)
L

ow
er

 L
im

it
 (

V
)

U
pp

er
 L

im
it

 (
V

)
L

ow
er

 L
im

it
 (

V
)

U
pp

er
 L

im
it

 (
V

)

–1
0

10
P

os
 F

S
9.

98
00

00
9.

97
77

98
9.

98
22

02
9.

97
69

00
9.

98
31

00

–1
0

10
0

0
–0

.0
01

60
3

0.
00

16
03

–0
.0

01
60

3
0.

00
16

03

–1
0

10
N

eg
 F

S
–9

.9
8

–9
.9

82
20

2
–9

.9
77

79
8

–9
.9

83
10

0
–9

.9
76

90
0

–5
5

P
os

 F
S

4.
99

4.
98

88
34

4.
99

11
66

4.
98

83
85

4.
99

16
15

–5
5

0
0

–0
.0

00
81

7
0.

00
08

17
–0

.0
00

81
7

0.
00

08
17

–5
5

N
eg

 F
S

–4
.9

9
–4

.9
91

16
6

–4
.9

88
83

4
–4

.9
91

61
5

–4
.9

88
38

5

–1
1

P
os

 F
S

0.
99

8
0.

99
77

31
0.

99
82

69
0.

99
76

41
0.

99
83

59

–1
1

0
0

–0
.0

00
18

9
0.

00
01

89
–0

.0
00

18
9

0.
00

01
89

–1
1

N
eg

 F
S

–0
.9

98
–0

.9
98

26
9

–0
.9

97
73

1
–0

.9
98

35
9

–0
.9

97
64

1

–0
.2

00
0.

20
0

P
os

 F
S

0.
19

96
0.

19
95

06
0.

19
96

94
0.

19
94

88
0.

19
97

12

–0
.2

00
0.

20
0

0
0

–0
.0

00
07

0
0.

00
00

70
–0

.0
00

07
0

0.
00

00
70

–0
.2

00
0.

20
0

N
eg

 F
S

–0
.1

99
6

–0
.1

99
69

4
–0

.1
99

50
6

–0
.1

99
71

2
–0

.1
99

48
8



© National Instruments Corporation 27 Isolated M/S Series Calibration Procedure

Ta
bl

e 
12

.  
NI

62
32

/6
23

3 
An

al
og

 O
ut

pu
t V

al
ue

s

R
an

ge
 (

V
)

T
es

t 
P

oi
nt

24
-H

ou
r 

L
im

it
s

1-
Y

ea
r 

L
im

it
s

M
in

im
um

M
ax

im
um

L
oc

at
io

n
V

al
ue

 (
V

)
L

ow
er

 L
im

it
 (

V
)

U
pp

er
 L

im
it

 (
V

)
L

ow
er

 L
im

it
 (

V
)

U
pp

er
 L

im
it

 (
V

)

–1
0

10
P

os
 F

S
9.

98
9.

97
76

71
9.

98
23

29
9.

97
67

73
9.

98
32

27

–1
0

10
0

0
–0

.0
01

73
0

0.
00

17
30

–0
.0

01
73

0
0.

00
17

30

–1
0

10
N

eg
 F

S
–9

.9
8

–9
.9

82
32

9
–9

.9
77

67
1

–9
.9

83
22

7
–9

.9
76

77
3

Ta
bl

e 
13

.  
NI

62
32

/6
23

3 
Co

un
te

r V
al

ue
s

Se
t 

P
oi

nt
 (

kH
z)

L
ow

er
 L

im
it

 (
kH

z)
U

pp
er

 L
im

it
 (

kH
z)

10
9.

99
95

10
.0

00
5



Isolated M/S Series Calibration Procedure 28 ni.com

NI
 6

23
6 

Te
st

 L
im

its
T

ab
le

s
14

 th
ro

ug
h

16
 in

cl
ud

e 
va

lu
es

 f
or

 th
e 

PC
I-

62
36

 a
nd

 P
X

I-
62

36
.

Ta
bl

e 
14

.  
NI

62
36

 A
na

lo
g 

In
pu

t V
al

ue
s

R
an

ge
 (

A
)

T
es

t 
P

oi
nt

24
-H

ou
r 

L
im

it
s

1-
Y

ea
r 

L
im

it
s

M
in

im
um

M
ax

im
um

L
oc

at
io

n
V

al
ue

 (
A

)
L

ow
er

 L
im

it
 (A

)
U

pp
er

 L
im

it
 (A

)
L

ow
er

 L
im

it
 (A

)
U

pp
er

 L
im

it
 (A

)

–0
.0

2
0.

02
P

os
 F

S
0.

01
99

6
0.

01
99

42
94

4
0.

01
99

77
05

6
0.

01
99

41
14

7
0.

01
99

78
85

3

–0
.0

2
0.

02
0

0
–0

.0
00

00
52

80
0.

00
00

05
28

0
–0

.0
00

00
52

80
0.

00
00

05
28

0

–0
.0

2
0.

02
N

eg
 F

S
–0

.0
19

96
–0

.0
19

97
70

56
–0

.0
19

94
29

44
–0

.0
19

97
88

53
–0

.0
19

94
11

47

Ta
bl

e 
15

.  
NI

62
36

 A
na

lo
g 

Ou
tp

ut
 V

al
ue

s

R
an

ge
 (

V
)

T
es

t 
P

oi
nt

24
-H

ou
r 

L
im

it
s

1-
Y

ea
r 

L
im

it
s

M
in

im
um

M
ax

im
um

L
oc

at
io

n
V

al
ue

 (
V

)
L

ow
er

 L
im

it
 (

V
)

U
pp

er
 L

im
it

 (
V

)
L

ow
er

 L
im

it
 (

V
)

U
pp

er
 L

im
it

 (
V

)

–1
0

10
P

os
 F

S
9.

98
9.

97
76

71
9.

98
23

29
9.

97
67

73
9.

98
32

27

–1
0

10
0

0
–0

.0
01

73
0

0.
00

17
30

–0
.0

01
73

0
0.

00
17

30

–1
0

10
N

eg
 F

S
–9

.9
8

–9
.9

82
32

9
–9

.9
77

67
1

–9
.9

83
22

7
–9

.9
76

77
3

Ta
bl

e 
16

.  
NI

62
36

 C
ou

nt
er

 V
al

ue
s

Se
t 

P
oi

nt
 (

M
H

z)
L

ow
er

 L
im

it
 (

M
H

z)
U

pp
er

 L
im

it
 (

M
H

z)

5
4.

99
97

5
5.

00
02

5



© National Instruments Corporation 29 Isolated M/S Series Calibration Procedure

NI
62

38
/6

23
9 

Te
st

 L
im

its
T

ab
le

s
17

 th
ro

ug
h

19
 in

cl
ud

e 
va

lu
es

 f
or

 th
e 

PC
I-

62
38

, P
X

I-
62

38
, P

C
I-

62
39

, a
nd

 P
X

I-
62

39
.

Ta
bl

e 
17

.  
NI

62
38

/6
23

9 
An

al
og

 In
pu

t V
al

ue
s

R
an

ge
 (

A
)

T
es

t 
P

oi
nt

24
-H

ou
r 

L
im

it
s

1-
Y

ea
r 

L
im

it
s

M
in

im
um

M
ax

im
um

L
oc

at
io

n
V

al
ue

 (
A

)
L

ow
er

 L
im

it
 (A

)
U

pp
er

 L
im

it
 (A

)
L

ow
er

 L
im

it
 (A

)
U

pp
er

 L
im

it
 (A

)

–0
.0

2
0.

02
Po

s 
F

S
0.

01
99

6
0.

01
99

42
94

4
0.

01
99

77
05

6
0.

01
99

41
14

7
0.

01
99

78
85

3

–0
.0

2
0.

02
0

0
–0

.0
00

00
52

80
0.

00
00

05
28

0
–0

.0
00

00
52

80
0.

00
00

05
28

0

–0
.0

2
0.

02
N

eg
 F

S
–0

.0
19

96
–0

.0
19

97
70

56
–0

.0
19

94
29

44
–0

.0
19

97
88

53
–0

.0
19

94
11

47

Ta
bl

e 
18

.  
NI

62
38

/6
23

9 
An

al
og

 O
ut

pu
t V

al
ue

s

R
an

ge
 (

V
)

T
es

t 
P

oi
nt

24
-H

ou
r 

L
im

it
s

1-
Y

ea
r 

L
im

it
s

M
in

im
um

M
ax

im
um

L
oc

at
io

n
V

al
ue

 (
A

)
L

ow
er

 L
im

it
 (

A
)

U
pp

er
 L

im
it

 (
A

)
L

ow
er

 L
im

it
 (

A
)

U
pp

er
 L

im
it

 (
A

)

0
0.

02
P

os
 F

S
0.

01
98

0.
01

97
55

85
0

0.
01

98
44

15
0

0.
01

97
54

06
8

0.
01

98
45

93
2

0
0.

02
0

0
–0

.0
00

01
34

60
0.

00
00

13
46

0
–0

.0
00

01
34

60
0.

00
00

13
46

0

Ta
bl

e 
19

.  
NI

62
38

/6
23

9 
Co

un
te

r V
al

ue
s 

Se
t 

P
oi

nt
 (

kH
z)

L
ow

er
 L

im
it

 (
kH

z)
U

pp
er

 L
im

it
 (

kH
z)

10
9.

99
95

10
.0

00
5



Isolated M/S Series Calibration Procedure 30 ni.com

Is
ol

at
ed

 S
 S

er
ie

s 
Te

st
 L

im
its

NI
 6

15
4 

Te
st

 L
im

its
T

ab
le

s
20

 th
ro

ug
h

22
 in

cl
ud

e 
va

lu
es

 f
or

 th
e 

PC
I-

61
54

.

Ta
bl

e 
20

.  
NI

61
54

 A
na

lo
g 

In
pu

t V
al

ue
s

R
an

ge
 (

V
)

T
es

t 
P

oi
nt

1-
Y

ea
r 

L
im

it
s

M
in

im
um

M
ax

im
um

L
oc

at
io

n
V

al
ue

 (
V

)
L

ow
er

 L
im

it
 (

V
)

U
pp

er
 L

im
it

 (
V

)

–1
0

10
P

os
 F

S
9.

98
9.

97
47

99
9.

98
52

01

–1
0

10
0

0
–0

.0
01

64
8

0.
00

16
48

–1
0

10
N

eg
 F

S
–9

.9
8

–9
.9

85
20

1
–9

.9
74

79
9

–5
5

P
os

 F
S

4.
99

4.
98

69
93

4.
99

30
07

–5
5

0
0

–0
.0

00
98

1
0.

00
09

81

–5
5

N
eg

 F
S

–4
.9

9
–4

.9
93

00
7

–4
.9

86
99

3

–2
2

P
os

 F
S

1.
99

1.
98

87
43

1.
99

12
57

–2
2

0
0

–0
.0

00
46

1
0.

00
04

61

–2
2

N
eg

 F
S

–1
.9

9
–1

.9
91

25
7

–1
.9

88
74

3

–1
1

P
os

 F
S

0.
99

8
0.

99
73

34
0.

99
86

66

–1
1

0
0

–0
.0

00
26

7
0.

00
02

67

–1
1

N
eg

 F
S

–0
.9

98
–0

.9
98

66
6

–0
.9

97
33

4



© National Instruments Corporation 31 Isolated M/S Series Calibration Procedure

Ta
bl

e 
21

.  
NI

61
54

 A
na

lo
g 

Ou
tp

ut
 V

al
ue

s

R
an

ge
 (

V
)

T
es

t 
P

oi
nt

1-
Y

ea
r 

L
im

it
s

M
in

im
um

M
ax

im
um

L
oc

at
io

n
V

al
ue

 (
V

)
L

ow
er

 L
im

it
 (

V
)

U
pp

er
 L

im
it

 (
V

)

–1
0

10
P

os
 F

S
9.

98
9.

97
20

17
9.

98
79

83

–1
0

10
0

0
–0

.0
04

35
0

0.
00

43
50

–1
0

10
N

eg
 F

S
–9

.9
8

–9
.9

87
98

3
–9

.9
72

01
7

Ta
bl

e 
22

.  
NI

61
54

 C
ou

nt
er

 V
al

ue
s

Se
t 

P
oi

nt
 (

M
H

z)
L

ow
er

 L
im

it
 (

M
H

z)
U

pp
er

 L
im

it
 (

M
H

z)

5
4.

99
97

5
5.

00
02

5



 

National Instruments, NI, ni.com, and LabVIEW are trademarks of National Instruments Corporation. 
Refer to the Terms of Use section on ni.com/legal for more information about National 
Instruments trademarks. Other product and company names mentioned herein are trademarks or trade 
names of their respective companies. For patents covering National Instruments products, refer to the 
appropriate location: Help»Patents in your software, the patents.txt file on your media, or 
ni.com/patents.

© 2007–2008 National Instruments Corporation. All rights reserved. 372010B-01 May08


	Isolated M/S Series Calibration Procedure
	Contents
	Conventions
	Software
	Documentation
	Calibration Interval
	Password
	Test Equipment
	Table 1. Recommended Calibration Equipment

	Test Conditions
	Calibration Procedure
	Initial Setup
	Self-Calibration
	Checking Device Temperature Changes
	Verification Procedure
	Analog Input Verification
	Table 2. Isolated M/S Series Device Analog Input Types
	Table 3. Analog Input Connections
	Analog Output Verification
	Table 4. Isolated M/S Series Device Analog Output Type and Channel Number
	Table 5. Analog Output Connections
	Figure 1. NI 6238/6239 Resistor Location
	Counter Verification
	Table 6. Counter Connections
	Figure 2. NI 6232/6238 Resistor Location
	Figure 3. NI 6233/6239 Resistor Location

	Adjustment Procedure
	Table 7. Calibrator Connections


	Test Limits
	Isolated M Series Test Limits
	NI 6230 Test Limits
	Table 8. NI 6230 Analog Input Values
	Table 9. NI 6230 Analog Output Values
	Table 10. NI 6230 Counter Values
	NI 6232/6233 Test Limits
	Table 11. NI 6232/6233 Analog Input Values
	Table 12. NI 6232/6233 Analog Output Values
	Table 13. NI 6232/6233 Counter Values
	NI 6236 Test Limits
	Table 14. NI 6236 Analog Input Values
	Table 15. NI 6236 Analog Output Values
	Table 16. NI 6236 Counter Values
	NI 6238/6239 Test Limits
	Table 17. NI 6238/6239 Analog Input Values
	Table 18. NI 6238/6239 Analog Output Values
	Table 19. NI 6238/6239 Counter Values

	Isolated S Series Test Limits
	NI 6154 Test Limits
	Table 20. NI 6154 Analog Input Values
	Table 21. NI 6154 Analog Output Values
	Table 22. NI 6154 Counter Values





